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INTRODUZIONE 

Il presente documento descrive l’approccio metodologico sviluppato da iiSBE Italia R&D, nel contesto del 

Progetto Europeo ADAPTNOW (ASP0100048 – Progetto co-finanziato dall’Unione Europea) che ha visto 

nella sua concreta applicazione come caso studio pilota proprio il Comune di Chivasso (TO). 

Si tratta di un approccio metodologico in grado di valutare il livello di rischio climatico di un qualsiasi 

territorio urbano, pertanto replicabile e esportabile anche ad altre realtà urbane. La metodologia sviluppata 

consente di elaborare mappe georeferenziate che mettono in luce le microzone urbane a maggiore 

vulnerabilità climatica, predisponendo specifiche misure di adattamento per prevenire e/o limitare i rischi 

legati ai cambiamenti climatici. 

 

Il Comune di Chivasso è il primo comune ad aver adottato tale visione strategica, con l’obiettivo di 

introdurre nel PRGC misure di adattamento ai cambiamenti climatici adattando il territorio e preservando 

la salute dei suoi cittadini. 

A seguire maggiori informazioni riguardanti le procedure di elaborazione delle mappe di esposizione, 

vulnerabilità e rischio ed un esempio pratico di applicazione della metodologia ad una microzona urbana di 

Chivasso, connotata da una elevata vulnerabilità climatica. 
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1. VALUTAZIONE DEL RISCHIO TEMPERATURE ESTREME RISPETTO ALLA 
SALUTE A SCALA DI CITTA’ 

1.1 LA METODOLOGIA E LE PROCEDURE DI CALCOLO 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Per calcolare il rischio di effetto isola di calore nel Comune di Chivasso, diretta conseguenza delle 

temperature estreme, è stato utilizzato uno strumento GIS per elaborare immagini satellitari contenenti 

informazioni sulla temperatura e sullo stato della vegetazione di un'area selezionata.  

Per la valutazione sono state utilizzate le immagini satellitari del Landsat-8 (https://earthexplorer.usgs.gov/). 

L’immagine satellitare derivante dal Landsat 8 è formata da due componenti: l'Operational Land Imager (OLI) 

e il Thermal Infrared Sensor (TIRS). Questi due sensori forniscono una copertura stagionale della massa 

continentale globale con una risoluzione spaziale di 30 metri.  

Valutazione del rischio per la salute rispetto 
alle temperature estreme 

 

Ottenimento dell’immagine satellitare 

(scaricare le mappe satellitari Landsat) 

Calcolare l’Esposizione 

(combinare i dati della popolazione < 10 anni e > 65 
anni) 

Calcolare la Vulnerabilità 

(combinare i valori dell’LST e della permeabilità) 

Assegnare il valore di Pericolo all’area 

Processare l’immagine satellitare 

(caricare in Qgis le bande 4, 5 e 10) 

https://earthexplorer.usgs.gov/
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Mappa satellitare di Chivasso presa dal portale ufficiale del Governo degli Stati Uniti 

 

 
Landsat 8 - C2 L2, mappa satellitare in cui è ricompreso il Comune di Chivasso 

 

Per la valutazione delle isole di calore sono state utilizzate la Banda 4, 5 e 10 o 11 dall'immagine satellitare 

Landsat 8 precedentemente scaricata. 

L’acquisizione dei dati e delle planimetrie satellitari finora citate rappresenta il punto di partenza per 

l’elaborazione delle mappe di esposizione e vulnerabilità che hanno consentito di operare una valutazione 

complessiva del rischio temperature estreme nel Comune di Chivasso. 

La formula che è stata utilizzata per valutare il rischio temperature estreme in riferimento alla salute deriva 

dal concetto di rischio introdotto nel sesto rapporto di valutazione del Gruppo intergovernativo di esperti sul 

cambiamento climatico (IPCC AR6). 

Di seguito la formula che è stata utilizzata per valutare il rischio temperature estreme in riferimento alla 

salute per la città di Chivasso: 

 𝐻𝑉𝑤𝐻𝑉 ×  𝐸𝑉𝑊𝐸𝑉 ×  𝑉𝑉𝑊𝑉 
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Dove: 

HV è il valore del PERICOLO  

EV è il valore dell’ESPOSIZIONE 

VV è il valore della VULNERABILITA’ 
 

WHV è il peso associato a HV 

WEV è il peso associato a EV 

WV è il peso associato a VV 

 

Esattamente come mostrato in precedenza, la mappa del rischio elaborata per la città di Chivasso prende 

contemporaneamente in considerazione tre fattori:  

▪ Temperatura della superficie terrestre (LST: Land Surface Temperature)  

▪ Permeabilità del suolo normalizzata (Corine Land Cover e Green Areas)  

▪ Popolazione vulnerabile (pop < 10 anni e pop > 65 anni) come elemento esposto 

 

Nei paragrafi successivi vengono descritte le diverse procedure utilizzate per l’ottenimento delle mappe 

necessarie all’elaborazione della valutazione di rischio. 

1.1.1 Valutazione del pericolo 

Per la valutazione del pericolo, è necessario assegnare un valore da 0 a 1 alla città di Chivasso a seconda della 

probabilità che l'evento si presenti nell'area (0 è una bassa probabilità che il pericolo si verifichi e 1 è un'alta 

probabilità che il pericolo si verifichi).  

Per determinare questo valore, è fondamentale controllare i dati storici e le diverse piattaforme ambientali 

che valutano il rischio dei territori per diversi tipi di pericolosità naturali e climatiche, in questo caso, per le 

isole di calore. L’ideale sarebbe avere un PAESC redatto per l’area rispetto alla quale si intende valutare il 

pericolo. Il valore stabilito viene quindi sostituito nella formula del rischio. 

Il livello di pericolo assegnato alla città di Chivasso è pari a 0,8.  

Applicando la formula del rischio, per la componente di pericolo climatico sono stati definiti i seguenti 

parametri: 

 

 

Dove: 

WHV è il peso associato a HV ed è pari a 0,25 per la città di Chivasso. 

1.1.2 Valutazione dell’esposizione 

La mappa dell’esposizione elaborata per la città di Chivasso prende contemporaneamente in considerazione 

i seguenti fattori:  

▪ Popolazione vulnerabile al di sotto dei 10 anni 

▪ Popolazione vulnerabile al di sopra dei 65 anni 

La rappresentazione grafica delle due variabili è stata elaborata in Qgis grazie all’utilizzo dei dati relativi alla 

popolazione vulnerabile, espressi per zona censuaria, contenuti in shapefile.  

𝑯𝑽𝒘𝑯𝑽 ×  𝐸𝑉𝑊𝐸𝑉 ×  𝑉𝑉𝑊𝑉  
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Per l’elaborazione della mappa relativa alla popolazione vulnerabile < 10 anni, è stato incrociato su Qgis lo 

shapefile relativo alla popolazione in oggetto con le diverse zone censuarie, generando la mappa che segue. 

 

 
Mappa relativa alla distribuzione della popolazione < 10 anni per zona censuaria. 

Per l’elaborazione della mappa relativa alla popolazione vulnerabile > 65 anni, è stato incrociato su Qgis lo 

shapefile relativo alla popolazione in oggetto con le diverse zone censuarie, generando la mappa che segue. 

 
Mappa relativa alla distribuzione della popolazione > 65 anni per zona censuaria. 
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Nella formula del rischio, per la componente relativa all’esposizione (pop < 10 anni e pop > 65 anni) sono 

stati definiti i seguenti parametri: 

 

 

Dove: 

WEV è il peso associato a EV ed è pari a 0,25 per la città di Chivasso. 

La mappa che segue è la risultante dal calcolo effettuato. 

 
Mappa dell’esposizione relativa alla città di Chivasso 

1.1.3 Valutazione della vulnerabilità 

La mappa della vulnerabilità elaborata per la città di Chivasso prende contemporaneamente in 

considerazione i seguenti fattori:  

▪ Temperatura della superficie terrestre (LST: Land Surface Temperature)  

▪ Permeabilità del suolo normalizzata (Corine Land Cover e Green Areas)  

A partire dallo strumento “raster calculator” in Qgis, i passaggi che hanno consentito di elaborare la mappa 

della temperatura della superficie terrestre (LST) sono stati i seguenti:  

I. Calcolare la riflettanza TOA (Top Of Atmosphere) per le bande 4 e 5 separatamente  

II. Calcolare la temperatura di luminosità (brightness temperature) TOA per la banda 10  

III. Calcolare l’NDVI (Normalized Differential Vegetation Index) 

IV. Calcolare una stima della Proporzione di Vegetazione (PV)  

V. Calcolare una stima dell’emissività della superficie terrestre  

VI. Calcolare una stima della temperatura della superficie terrestre (LST)  
 

𝐻𝑉𝑤𝐻𝑉 ×  𝑬𝑽𝑾𝑬𝑽 ×  𝑉𝑉𝑊𝑉 
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La procedura fin qui descritta permette di ottenere la mappa relativa alla temperatura della superficie 

terrestre (LST: Land Surface Temperature) per la città di Chivasso. 

 
Mappa della temperatura superficiale (LST) al suolo relativa a Chivasso 

 

Il secondo fattore da prendere in considerazione per elaborare la mappa della vulnerabilità è la permeabilità 

del suolo. Per procedere all’elaborazione della mappa è necessario caricare in Qgis contemporaneamente il 

Corine Land cover file, lo shapefile delle aree verdi della città di Chivasso e le zone censuarie. Le zone 

censuarie a loro volta riportano le porzioni di terreno permeabile e impermeabile; sottraendo da 

quest’ultime la quota di terreno permeabile, si ottiene la mappa dell’impermeabilità della zona, come segue. 

 
Mappa dell’impermeabilità relativa a Chivasso 
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Nella formula del rischio, per la componente relativa alla vulnerabilità, sono stati definiti i seguenti parametri: 

 

 

Dove: 

WV è il peso associato a VV ed è pari a 0,50 per la città di Chivasso. 

La mappa che segue è la risultante dal calcolo effettuato. 

 
Mappa della vulnerabilità relativa alla città di Chivasso 

1.1.4 Valutazione del rischio complessivo 

Per procedere con il calcolo del rischio, tutti i livelli devono essere normalizzati in valori da 0 a 1. 

una volta normalizzati i valori sarà possibile valutare il rischio temperature estreme in riferimento alla salute 

per la città di Chivasso, applicando la seguente formula: 

 

 

Dove: 

HV è il valore del PERICOLO  

EV è il valore dell’ESPOSIZIONE 

VV è il valore della VULNERABILITA’ 

 

WHV è il peso associato a HV, per il Comune di Chivasso è stato fissato a 0,25 

WEV è il peso associato a EV, per il Comune di Chivasso è stato fissato a 0,25 

WV è il peso associato a VV, per il Comune di Chivasso è stato fissato a 0,50 

 

 

𝐻𝑉𝑤𝐻𝑉 ×  𝐸𝑉𝑊𝐸𝑉 ×  𝑽𝑽𝑾𝑽 

𝐻𝑉𝑤𝐻𝑉 ×  𝐸𝑉𝑊𝐸𝑉 ×  𝑉𝑉𝑊𝑉 
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Mappa del rischio relativa a Chivasso 

2. ZONIZZAZIONE E IDENTIFICAZIONE DELLE AREE MICRO URBANE 

2.1 VALUTAZIONE DEL RISCHIO NELLE MICRO AREE URBANE 

Partendo dalla mappa del rischio complessivo, elaborata per la città di Chivasso, si è scesi di scala andando 

ad individuare delle microzone urbane rappresentative delle zone a maggior rischio temperature estreme in 

relazione alla salute degli abitanti. Per agevolare la perimetrazione delle aree urbane è stata introdotta una 

griglia con interassi fissi di 50 x 50 metri, la quale ha consentito, insieme con il grafo stradale, il tessuto 

urbanistico e le zone censuarie, di individuare 20 microzone urbane, contraddistinte con codice alfabetico, 

sulle quali andare a verificare il livello di vulnerabilità, come riportato nella mappa sottostante. 

 
Planimetria con in evidenza le 20 microzone urbane individuate in Chivasso 
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L’analisi alla scala micro-urbana consente di circoscrivere in maniera efficace quelle che sono le 

problematiche in termini di adattamento ai cambiamenti climatici e, di conseguenza, permette una più facile 

individuazione delle opportune misure di resilienza e adattamento da inserire per rendere la zona meno 

vulnerabile. Nella maggior parte dei casi, sono stati individuati dei “baricentri di adattamento” all’interno 

delle microzone urbane; si tratta di elementi che fungono da nodo per l’intera area, nella maggior parte dei 

casi si tratta di piazze ma sono anche considerati tali gli edifici pubblici di interesse (scuole, municipio, ecc.). 

Le misure di adattamento che verranno introdotte ai diversi “baricentri di adattamento”, potranno 

positivamente condizionare gli edifici al loro intorno ed è questa la ragione per cui le microzone individuate 

hanno dimensioni contenute in termini di estensione superficiale. 

Per ciascuna delle 20 microzone è stato anche calcolato il rischio medio, al fine di classificare con maggiore 

precisione le parti della città maggiormente vulnerabili alle temperature estreme. 

Planimetria con in evidenza i valori medi di rischio per le 20 microzone urbane individuate in Chivasso 
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3. VALUTAZIONE DEL RISCHIO TEMPERATURE ESTREME A SCALA MICRO 

URBANA 
3.1 CRITERI PER LA VALUTAZIONE 

La valutazione del rischio temperature estreme a scala micro-urbana nel contesto del Comune di Chivasso è 

stata condotta grazie all’utilizzo di specifici criteri che hanno consentito di valutare i parametri che 

maggiormente influenzano il rischio di effetto isola di calore, dovuto alle temperature estreme.  

Di seguito vengono descritti in forma tabellare i criteri utilizzati per l’analisi e i relativi indicatori, dettagliando 

l’unità di misura e il metodo di calcolo.  

3.1.1 Capacità delle superfici pavimentate di riflettere la radiazione solare 

T.E.1 Capacità delle superfici pavimentate di riflettere la radiazione solare 

Descrizione Questo criterio utilizza il valore medio dell'Indice di Riflettanza Solare (SRI) 
calcolato per tutte le superfici orizzontali pavimentate di un'area urbana per 
stimare l'efficacia complessiva nel ridurre l'accumulo di calore. L'obiettivo 
principale è valutare la capacità dell'area urbana di riflettere la radiazione 
solare e dissipare il calore accumulato, mitigando l'effetto dell'isola di calore 
urbano. Più alto è il valore medio dell'SRI, più efficiente sarà l'area urbana 
nella gestione dell'energia solare, migliorando la vivibilità degli spazi urbani e 
contribuendo a ridurre gli impatti ambientali associati all'accumulo di calore. 

indicatore Indice di Riflessione Solare (SRI) 

Unità di misura  Adimensionale 

Valori di riferimento Classe valore di vulnerabilità critica (1) – SRI = 0 

Classe valore di vulnerabilità neutra (0,5) – SRI = 29 

Classe valore di vulnerabilità ottimale (0) – SRI = 58 

Riferimento 
Normativo 

CAM Edilizia 2023 

Metodo di verifica Per calcolare il valore dell’indicatore: 
 

• identificare le tipologie di materiali delle superfici pavimentate (strade, 
marciapiedi, parcheggi, piazze, ecc.) presenti nella zona urbana. Nel 
calcolo non vanno considerate le coperture (tetti piani e tetti a falda) e 
le aree verdi. 
Denotare ciascuna tipologia di materiale con l'indice 𝑖, dove 𝑖 = 1,2,3…, 
n, e n rappresenta il numero totale di tipologie di materiali pavimentati 
identificate; 

• per ogni tipologia di materiale 𝑖, associare un valore di Indice di 
Riflessione Solare SRIi; 

• calcolare l’estensione complessiva (Ai) di ogni tipologia di materiale i; 
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• calcolare il valore ponderato per ciascuna tipologia di materiale 
moltiplicando il valore di SRI per l’area corrispondente: 

 

 
 
 

• sommare i valori ponderati di tutte le tipologie di materiali 

 
 

• calcolare la superficie complessiva di tutte le tipologie di materiali 
 

 
 

• calcolare il valore medio di SRI 
 

 

 

3.1.2 Capacità delle coperture di riflettere la radiazione solare 

 T.E.2 Capacità delle coperture di riflettere la radiazione solare 

Descrizione Questo criterio utilizza il valore medio dell'Indice di Riflettanza Solare (SRI) 
calcolato per tutte le coperture di un'area urbana per stimare l'efficacia 
complessiva nel ridurre l'accumulo di calore. L'obiettivo principale è valutare la 
capacità dell'area urbana di riflettere la radiazione solare e dissipare il calore 
accumulato, mitigando l'effetto dell'isola di calore urbano. Più alto è il valore 
medio dell'SRI, più efficiente sarà l'area urbana nella gestione dell'energia 
solare, migliorando la vivibilità degli spazi urbani e contribuendo a ridurre gli 
impatti ambientali associati all'accumulo di calore. 

indicatore Indice di Riflessione Solare (SRI) 

Unità di misura  Adimensionale 
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Valori di riferimento 

 

Coperture con 
pendenza > 15% 

Coperture con pendenza inferiore a 15° 

Classe valore di vulnerabilità critica (1) – SRI = 0 

Classe valore di vulnerabilità neutra (0,5) – SRI = 29 

Classe valore di vulnerabilità ottimale (0) – SRI = 58 

 

Coperture con pendenza inferiore a 15° 

Classe valore di vulnerabilità critica (1) – SRI = 50 

Classe valore di vulnerabilità neutra (0,5) – SRI = 75 

Classe valore di vulnerabilità ottimale (0) – SRI = 100 

 

Riferimento 
Normativo 

CAM Edilizia 2023 

Metodo di verifica Per calcolare il valore dell’indicatore: 
 

• identificare le tipologie di materiali delle coperture. 
Denotare ciascuna tipologia di materiale con l'indice 𝑖, dove 𝑖 = 1,2,3…, 
n, e n rappresenta il numero totale di tipologie di materiali identificate; 

• per ogni tipologia di materiale 𝑖, associare un valore di Indice di 
Riflessione Solare SRIi; 

• calcolare l’estensione complessiva (Ai) di ogni tipologia di materiale i; 
• calcolare il valore ponderato per ciascuna tipologia di materiale 

moltiplicando il valore di SRI per l’area corrispondente: 
 

 
 
 

• sommare i valori ponderati di tutte le tipologie di materiali 

 
 

• calcolare la superficie complessiva di tutte le tipologie di materiali 
 

 
 

• calcolare il valore medio di SRI 
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Dato che i valori di riferimento delle classi di vulnerabilità sono differenti, 
questa procedura di calcolo va applicata separatamente per le coperture con 
inclinazione superiore ai 15° e per quelle con inclinazione inferiore ai 15°. 
 

 

3.1.3 Riflessività zona urbana 

T.E.3 Riflessività zona urbana 

Descrizione La riflessività della zona urbana viene misurata attraverso l’albedo. Per albedo 
si intende la frazione di luce solare che viene diffusamente riflessa da un corpo 
ed è definita dal rapporto tra la radiosità e l'irraggiamento ricevuto da una 
superficie. La albedo viene misurata su una scala che va da 0 (corrispondente a 
un corpo nero che assorbe tutta la radiazione incidente) a 1 (corrispondente a 
un corpo che riflette tutta la radiazione incidente). La proporzione riflessa non 
è solo determinata dalle proprietà della superficie stessa, ma anche dalla 
distribuzione spettrale e angolare della radiazione solare che raggiunge la 
superficie terrestre; questi fattori variano con la composizione atmosferica, la 
posizione geografica e il tempo; per questo se si va a considerare le differenze 
dei diversi materiali si può constatare come più una superficie è riflettente, più 
alto è il valore dell'albedo. L’obiettivo è quello di massimizzare la riflessione 
della radiazione solare al fine di evitare che si generino isola di calore urbano 
tra gli edifici. 

indicatore Albedo medio 

Unità di misura  Adimensionale 

Valori di riferimento Classe valore di vulnerabilità critica (1) – Albedo medio = 0,1 

Classe valore di vulnerabilità neutra (0,5) – Albedo medio = 0,35 

Classe valore di vulnerabilità ottimale (0) – Albedo medio = 0,6 

Riferimento 
Normativo 

Letteratura scientifica 

Metodo di verifica Per calcolare il valore dell’indicatore è possibile utilizzare il software 
opensource QGIS.  
In QGIS è, infatti, possibile calcolare l’albedo di una superficie basandosi sui dati 
satellitari, utilizzando i valori di riflettanza delle diverse bande in un’immagine 
multispettrale. L’albedo viene generalmente calcolato come la frazione di 
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energia solare riflessa da una superficie rispetto alla quantità totale di energia 
solare in entrata. Per calcolare l’indicatore procedere come riportato di seguito:  

• Preparare i Dati:  
Utilizza un’immagine multispettrale che abbia bande nello spettro del 
visibile e nell’infrarosso vicino (NIR). Per questa analisi è stata utilizzata 
un’immagine del satellite Landsat 8. Assicurati che ciascuna banda sia 
calibrata alla riflettanza "top-of-atmosphere" (TOA). Per alcuni dati 
satellitari (es. Landsat), questo passaggio potrebbe già essere stato 
effettuato. In caso contrario, dovrai eseguire questa operazione 
utilizzando i valori di radianza forniti con l’immagine. 
 

• Caricare l’Immagine Satellitare: Importa il file raster multispettrale 
(come .tif) in QGIS tramite Layer > Aggiungi Layer > Aggiungi Layer 
Raster. 
 

• Calcolare la Riflettanza per Ciascuna Banda (se necessario): 
Se stai lavorando con dati grezzi, converti la radianza in riflettanza per 
ciascuna banda utilizzando la formula e il fattore di scala appropriati. 
Questo passaggio potrebbe non essere richiesto se i dati sono già stati 
convertiti in riflettanza. 
 

• Aprire il Calcolatore Raster: 
Vai su Raster > Calcolatore Raster. Nel Calcolatore Raster, puoi inserire 
un’espressione per calcolare l’albedo. 
 

• Definire la Formula di Calcolo dell’Albedo:  
La formula per l’albedo varia in base alle bande specifiche utilizzate nei 
tuoi dati. Ai fini di questa analisi è stata utilizzata la formula per 
calcolare l’albedo nell’infrarosso vicino. 

 
Dove 
α = la banda corrispondente all’infrarosso vicino di Landsat. 
 
Ecco come inserire questa formula: 
Inserisci ciascuna banda con il suo peso corrispondente. Sostituisci 
Banda 2, Banda 4, ecc., con i nomi dei layer nel tuo progetto (potrebbe 
essere necessario controllare i nomi delle bande nel pannello Layer). 
Inserisci questa formula nel Calcolatore Raster, assicurandoti di 
utilizzare i numeri delle bande e i coefficienti corretti per la tua 
immagine satellitare. 
 

• Eseguire il Calcolo:  
Scegli una posizione di output e un nome per il file raster dell’albedo 
calcolato. Clicca su OK per creare il layer raster dell’albedo. 
 

• Visualizzare e Analizzare il Layer dell’Albedo: 
Il layer generato mostrerà i valori di albedo, generalmente compresi tra 
0 (nessuna riflettanza) e 1 (riflettanza totale). Stila il layer per 
visualizzare meglio l’albedo nell’area di studio. 
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3.1.3 Disponibilità aree verdi 

T.E.4 Disponibilità aree verdi 

Descrizione Il criterio valuta la capacità di un'area urbana di mitigare l'effetto isola di 
calore attraverso la presenza e distribuzione di aree verdi, considerando 
la percentuale di aree verdi rispetto alla superficie totale urbana. Le aree 
verdi includono parchi, giardini pubblici, boschi urbani, tetti verdi e altre 
superfici vegetate. Questo indicatore è cruciale per promuovere il 
raffreddamento naturale e migliorare il microclima urbano, riducendo le 
temperature locali e migliorando il comfort termico. 

indicatore Percentuale di aree verdi sul totale dell'area urbana 

Unità di misura  Percentuale % 

Valori di riferimento Classe valore di vulnerabilità critica (1) – Percentuale aree verdi = 0 % 

Classe valore di vulnerabilità neutra (0,5) – Percentuale aree verdi = 36 % 

Classe valore di vulnerabilità ottimale (0) – Percentuale aree verdi = 72 % 

Riferimento 
normativo 

CAM Edilizia 2023 

Metodo di verifica Per calcolare il valore dell’indicatore: 
 

• Calcolare l’estensione dell’area urbana 
• Misurare l'estensione complessiva delle aree verdi nell’area 

urbana. Utilizzare mappe o immagini satellitari ad alta risoluzione. 
Le aree verdi includono parchi, giardini, prati e altre superfici 
vegetate. 

•  Calcolare il valore dell’indicatore applicando la seguente formula: 
   

 
 

 

3.1.5 Superfici pavimentate ombreggiate 

T.E.5 Superfici pavimentate ombreggiate 

Descrizione Questo criterio valuta la quantità di superficie urbana coperta da ombra in un 
momento specifico, ossia alle ore 12:00 del 21 giugno (giorno del solstizio 
d’estate), ed è utile per comprendere l’efficacia delle strategie urbane nella 
mitigazione delle isole di calore e nella promozione del comfort termico degli 
spazi pubblici. Calcolato come rapporto tra l’area complessiva delle superfici 
ombreggiate e l’area totale della zona urbana in esame, fornisce un valore 
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percentuale che evidenzia quanto sia diffusa l’ombra nelle ore centrali della 
giornata estiva. Attraverso l’analisi delle proiezioni d’ombra di edifici, 
vegetazione e altre strutture ombreggianti, l’indicatore consente di valutare 
l’efficacia della pianificazione urbana nel generare ombra naturale o artificiale 
e ridurre il riscaldamento eccessivo delle superfici. Questo dato diventa utile 
per orientare politiche e interventi, come l’aumento di aree verdi, la 
piantumazione di alberi in posizioni strategiche o la realizzazione di strutture 
ombreggianti nei punti critici. Il monitoraggio nel tempo della percentuale di 
aree ombreggiate è utile per verificare l’impatto delle politiche di 
rigenerazione urbana e sostenibilità. 

indicatore Percentuale delle superfici pavimentate ombreggiate alle ore 12:oo del 21 
giugno sul totale delle aree pavimentate. 

Unità di misura  Percentuale % 

Valori di riferimento Classe valore di vulnerabilità critica (1) – Percentuale aree ombreggiate = 0 % 

Classe valore di vulnerabilità neutra (0,5) – Percentuale aree ombreggiate = 25 
% 

Classe valore di vulnerabilità ottimale (0) – Percentuale aree ombreggiate = 50 
% 

Riferimento 
Normativo 

Letteratura scientifica 

Metodo di verifica Per calcolare il valore dell’indicatore: 
 

• Determinare l'area complessiva della zona urbana in esame. 
• Identificare e mappare edifici, alberi e altre strutture che possono 

generare ombra in quella zona specifica. 
• Usare un sistema GIS (Geographic Information System) o software di 

modellazione 3D, come AutoCAD o SketchUp, per rappresentare le 
strutture in grado di generare ombra alle ore 12:00 del 21 giugno. 

• Utilizzare il software di modellazione per simulare l’ombra proiettata 
da edifici e vegetazione alle ore 12:00 del 21 giugno. Considerare la 
posizione geografica della zona urbana e l’angolo d'inclinazione del sole 
al solstizio d’estate. 

• Eseguire la modellazione 3D per calcolare con precisione l’estensione 
delle aree ombreggiate, tenendo conto dell’altezza delle strutture e 
della distanza tra di esse. 

• Misurare la superficie totale delle aree ombreggiate proiettate a terra 
alle ore 12:00. 

• Applicare la seguente formula per calcolare la percentuale di aree 
ombreggiate: 
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3.1.6 Vista della volta celeste 

T.E.6 Vista della volta celeste 

Descrizione Lo Sky View Factor, o più semplicemente abbreviato come SVF, è una metrica 
fondamentale negli studi urbani e ambientali, in quanto, misura la porzione di 
cielo visibile da un punto specifico, influenzando le condizioni di temperatura e 
i livelli di radiazione negli spazi urbani.  

Lo SVF è essenziale per descrivere la climatologia urbana a scale inferiori a 
circa 100 m, questo proxy per la radiazione netta dipende dall'altezza degli 
ostacoli nei suoi dintorni. L’obiettivo è, quindi, quello di massimizzare la 
dispersione del calore accumulato dalle superfici pavimentate durante il 
giorno attraverso il raffreddamento radiativo notturno. 

indicatore  Sky View Factor medio 

Unità di misura  Adimensionale 

Valori di riferimento Classe valore di vulnerabilità critica (1) – Sky View Factor = 0 % 

Classe valore di vulnerabilità neutra (0,5) – Sky View Factor = 50 % 

Classe valore di vulnerabilità ottimale (0) – Sky View Factor = 100 % 

Riferimento 
Normativo 

Letteratura scientifica 

Metodo di verifica Per calcolare il valore dell’indicatore è possibile utilizzare il software 
opensource di calcolo QGIS. Di seguito viene descritto come calcolare lo Sky 
View Factor (SVF) in QGIS utilizzando il plugin UMEP (Urban Multi-scale 
Environmental Predictor. 
Calcolare l'SVF in QGIS con UMEP 

• Configura l’Ambiente di QGIS 
Assicurati che QGIS sia installato (si consiglia la versione 3.10 o 
successiva). 
Installa il plugin UMEP: in QGIS, vai su Plugin > Gestisci e Installa Plugin, 
cerca "UMEP" e installalo. 
Carica un Modello di Superficie Digitale (DSM) o un Modello Digitale di 
Elevazione (DEM) che rappresenti le altezze delle superfici di edifici, 
vegetazione e terreno. 
 

• Prepara il Progetto 
Aggiungi il DSM o DEM a QGIS (Layer > Aggiungi Layer > Aggiungi Layer 
Raster...). 
Imposta il sistema di riferimento di coordinate (CRS) del progetto in 
modo che corrisponda all’area di studio, poiché il CRS influisce 
sull'accuratezza delle misurazioni. 
 

• Apri lo Strumento Sky View Factor 
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Nella barra degli strumenti principale di QGIS, vai a UMEP > Pre-
Processor > Sky View Factor (SVF) Calculator. 
 

• Configura i Parametri dell'SVF 
Lo strumento SVF Calculator ti chiederà di configurare alcuni parametri: 
Raster DSM: seleziona il layer DSM o DEM che rappresenta le elevazioni 
delle superfici. 
Risoluzione (metri): imposta la risoluzione spaziale dell’output in metri. 
Idealmente, dovrebbe essere simile a quella del DSM/DEM. 
Altezza del Punto di Osservazione: definisci l’altezza del punto di 
osservazione dal suolo (es. 1,5 metri per un'analisi a livello pedonale). 
Distanza Massima di Ricerca: specifica la distanza massima in metri da 
considerare per i calcoli di visibilità. Distanze maggiori aumentano i 
tempi di elaborazione. 
Divisioni Azimut e Zenith: questi parametri controllano la precisione 
dei calcoli SVF: 
Divisioni azimutali: valori tipici vanno da 16 a 32 (valori più alti 
aumentano la precisione). 
Divisioni zenithali: generalmente impostate tra 8 e 16. 
Directory di Output: specifica dove salvare i risultati dell'SVF. 
 

• Esegui il Calcolo SVF 
Clicca su Run per avviare il calcolo. Il tempo necessario dipenderà 
dall’estensione e dalla risoluzione del DSM, nonché dalle divisioni 
azimutali e zenithali scelte. 
Al termine, UMEP salva l’output SVF nella directory specificata e lo 
aggiunge al progetto QGIS come layer raster. 
 

• Visualizza e Interpreta i Risultati 
Il layer SVF visualizza valori compresi tra 0 e 1: 
0 indica una vista del cielo completamente ostruita. 
1 significa che il cielo è completamente visibile. 
Regola la simbologia dei colori per visualizzare meglio le variazioni 
dell'SVF nell’area di studio. Questo può aiutare a identificare aree con 
un'ombreggiatura urbana significativa o spazi aperti. 
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Fig. 1 – Zona G in evidenza su ortofotocarta Fig. 2 – Zona G in evidenza su planimetria 

Fig. 3 – Vista aerea Zona G. Fonte Google Earth 

3.2 ZONA G 

L’area urbana identificata come “Zona G” si estende a Nord-Est dell’impianto storico della Città di Chivasso, 
proprio accanto al polo ospedaliero della città, che ne definisce il confine a Ovest. Si tratta, infatti, di un’area 
urbanistica di relativamente recente espansione, costituita da edifici residenziali realizzati negli anni Settanta. 
 
La Zona G confina a Nord con via Eugenio Clara e con la ferrovia, Ovest con l’Ospedale di Chivasso, a Sud dalla 
SP 11 Padana Superiore mentre ad Est, il limite dalla zona è identificato con via Mazzè. 
 
       
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Gli edifici che costituiscono la Zona G sono per la quasi totalità palazzine residenziali pluripiano; lungo la 
direttrice SP 11 Padana Superiore sono altresì presenti fabbricati residenziali di altezza inferiore, al cui piano 
terra sono insediate diverse attività commerciali. Nella Zona G è, inoltre, presente una scuola dell’infanzia 
privata, un’area gioco attrezzata a Nord e, tangente quest’ultima, una zona adibita a parcheggio a raso. 
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Fig. 4 – Zonizzazione catastale in elaborato Qgis Fig. 5 – Indicazione planimetrica degli edifici rilevanti nella Zona G  

 
Il baricentro climatico della Zona G è posto a Nord, nell’area gioco attrezzata, utilizzata come zona di 
ricreazione, area sgambamento cani e luogo di socializzazione. La strategia di adattamento per la zona in 
questione sarà costruita tenendo in considerazione anche l’area a parcheggio a raso, adiacente l’area 
attrezzata.  
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Fig. 6 – Elementi e finiture caratterizzanti le superfici della Zona G  

3.2.1 Valutazione della vulnerabilità attuale 

Al fine di verificare la vulnerabilità della Zona G, contraddistinta nella mappa del rischio come la più 

problematica, sono stati calcolati gli indicatori selezionati per la valutazione del rischio temperature estreme 

a scala micro-urbana. 
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T.E.1 Capacità delle superfici pavimentate di riflettere la radiazione solare 

Esigenza Ridurre l’assorbimento di calore da parte delle superfici pavimentate 

indicatore Indice di Riflessione Solare medio (SRI) 

Unità di misura  Adimensionale 

Classi di prestazione • Ottimale (0) - SRI medio = 58 
• Critica (1) - SRI medio = 0 

Planimetria 

 

Elementi di supporto 
al calcolo 
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Materiale Pavimentazione Area 
(m²) 

Elementi SRI 

Autobloccante 
rosso 

 

842 Cortili 25 

Autobloccante 
chiaro 

 

4480 
Cortili, marciapiedi, 

strade 
37 

Ghiaia 

 

584 Strade, cortili 27 

Porfido 

 

639 cortili 15 

Asfalto 

 

14258 
Strade, marciapiedi, 

parcheggi 
6 

Calcestruzzo chiaro 

 

5738 Cortili 21 

Asfalto chiaro 

 

621 Cortili 27 

Autobloccante 
grigliato 

 

187 Cortili 40 

TOTALE 27348   
 

Valore attuale 
dell’indicatore Indice di Riflessione Solare medio (SRI medio) = 16 

Classe valore 
vulnerabilità 0,72 – PIUTTOSTO NEGATIVO 
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T.E.2 Capacità delle coperture di riflettere la radiazione solare 

Esigenza Ridurre l’assorbimento di calore da parte delle coperture 

indicatore Indice di Riflessione Solare medio (SRI) 

Unità di misura  Adimensionale 

Classi di prestazione Coperture con pendenza maggiore di 15° 
• Ottimale (0) - SRI medio = 58 
• Critica (1) - SRI medio = 0 

 
Coperture con pendenza pari o minore di 15° 

• Ottimale (0) - SRI medio = 100 
• Critica (1) - SRI medio = 50 

Planimetria 
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Elementi di supporto 
al calcolo 

Pendenza copertura Materiale Superficie 
(m2) 

SRI SRI Medio   

maggiore di 15° Tegole rosse 11676,5 36 37 

Metallo 944,5 56 

Pannelli solari 203 10 

pari o minore di 15° Bitume 1305 1 1 

 
 

Valore attuale 
dell’indicatore 

Coperture con pendenza maggiore di 15° 
Indice di Riflessione Solare medio (SRI medio) = 37 
 
Coperture con pendenza pari o minore di 15° 
Indice di Riflessione Solare medio (SRI medio) = 1 

Classe valore 
vulnerabilità 

Coperture con pendenza maggiore di 15° 
0,36 – PIUTTOSTO POSITIVO 
 
Coperture con pendenza pari o minore di 15° 
1 – CRITICO 
 
Classe valore di vulnerabilità ponderato per l’estensione delle tipologie di 
coperture:  
0,42 - NEUTRALE 

 

T.E.3 Riflettività zona urbana 

Esigenza Massimizzare la riflessione della radiazione solare 

indicatore Albedo medio 

Unità di misura  Adimensionale 

Classi di prestazione • Ottimale (0) - Albedo medio = 0,6 
• Critica (1) - Albedo medio = 0,1 
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Planimetria 

 

Elementi di supporto 
al calcolo Calcolo effettuato utilizzando Qgis 

Valore attuale 
dell’indicatore Albedo medio = 0,27 

Classe valore 
vulnerabilità 0,66 – PIUTTOSTO NEGATIVO 

 

T.E.4 Disponibilità aree verdi 

Esigenza Ridurre le temperature a livello locale attraverso l’evotraspirazione 

indicatore Estensione aree verdi / superficie zona urbana 

Unità di misura  % 

Classi di prestazione • Ottimale (0) – Estensione aree verdi / superficie zona urbana = 72% 
• Critica (1) - Estensione aree verdi / superficie zona urbana = 0% 
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Planimetria 

 

Elementi di supporto 
al calcolo 

 
Superficie (m²) 

Aree verdi 10260 

Area urbana  54492 
 

Valore attuale 
dell’indicatore Estensione aree verdi / superficie zona urbana = 19% 

Classe valore 
vulnerabilità 0,74 – PIUTTOSTO NEGATIVO 
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T.E.5 Superfici pavimentate ombreggiate 

Esigenza Ridurre l’accumulo di calore minimizzando la radiazione diretta incidente sulle 
aree pavimentate 

indicatore Aree pavimentate ombreggiate (al 21.06 ore 12.00) / superficie zona urbana 

Unità di misura  % 

Classi di prestazione • Ottimale (0) – aree pavimentate ombreggiate (al 21.06 ore 12.00) / 
superficie zona urbana = 50 % 

• Critica (1) - aree pavimentate ombreggiate (al 21.06 ore 12.00) / 
superficie zona urbana = 0 % 

Planimetria 

 

Elementi di supporto 
al calcolo 

 
Superficie (m²) 

Aree pavimentate 
ombreggiate (al 21.06 
ore 12.00) 

5379 

Aree pavimentate 27348 
 

Valore attuale Aree pavimentate ombreggiate (al 21.06 ore 12.00) / superficie zona urbana = 
20% 
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dell’indicatore 

Classe valore 
vulnerabilità 0,60 – NEUTRALE 

 

T.E.6 Vista della volta celeste 

Esigenza Massimizzare la dispersione del calore accumulato dalle superfici pavimentate 
durante il giorno attraverso il raffreddamento radiativo notturno 

indicatore  Sky View Factor medio 

Unità di misura  Adimensionale 

Classi di prestazione • Ottimale (0) – Sky View Factor medio = 1 
• Critica (1) - Sky View Factor medio = 0 

Planimetria 

 

Elementi di supporto 
al calcolo Calcolo effettuato utilizzando Qgis 
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Valore attuale 
dell’indicatore Sky View Facrtor medio = 0,74 

Classe valore 
vulnerabilità 0,26 – PIUTTOSTO POSITIVO 

 

3.2.2 Vulnerabilità complessiva 

Sulla base dei singoli valori di vulnerabilità ottenuti per i criteri calcolati, è possibile calcolare la vulnerabilità 

complessiva relativa alla Zona G, applicando la seguente formula: 

 

Nella tabella seguente sono riportati i valori normalizzati e relativo peso per i criteri calcolati. 

Codice Criterio 
Classe 

vulnerabilità 
Valore 

normalizzato 
Peso 

T.E.1 
Capacità delle superfici pavimentate di 
riflettere la radiazione solare 

Piuttosto 
negativo 

0,72 25% 

T.E.2 
Capacità delle coperture di riflettere la 
radiazione solare 

Neutrale 
0,42 15% 

T.E.3 Riflettività zona urbana 
Piuttosto 
negativo 

0,66 15% 

T.E.4 Disponibilità aree verdi 
Piuttosto 
negativo 

0,74 25% 

T.E.5 Superfici pavimentate ombreggiate 
Neutrale 

0,60 10% 

T.E.6 Vista della volta celeste 
Piuttosto 
positivo 

0,26 10% 

 

Classe valore vulnerabilità complessiva = 0,61 - PIUTTOSTO NEGATIVO 

Nel complesso l'area urbana presenta alcune criticità in relazione soprattutto alla capacità di riflettere la 

radiazione solare da parte delle superfici pavimentate (30% c.a. superficie urbana coperta da asfalto nero) e 

alla non elevata disponibilità di aree verdi. L'unico aspetto che risulta “piuttosto positivo” è la "vista della 

volta celeste", che permette una discreta dispersione del calore durante la notte, anche se questo non è 

sufficiente a compensare le altre vulnerabilità critiche. 

 

3.2.3 Risultato della valutazione e interventi migliorativi 

T.E.1 Capacità delle superfici pavimentate di riflettere la radiazione solare 

Classe valore 
vulnerabilità attuale 

0,72 – PIUTTOSTO NEGATIVO 

𝑉𝑉 =   (𝐼𝑖  ×  𝑊𝑖)

𝑛

𝑖=1
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Classe valore 
vulnerabilità neutrale SRI medio pari a 29. 

Per raggiungere la classe del valore di vulnerabilità NEUTRALE, è necessario 
raggiungere un valore dell’indicatore SRI medio pari a 29. Ciò comporta un 
incremento dell’80% del valore attuale dell’indicatore. Il valore SRI medio pari 
a 29 è il requisito indicato per le aree esterne in riferimento alle isole di calore 
nei CAM Edilizia. 

Misure di 
adattamento  

A titolo di esempio, la sostituzione di 10.000 m2 (su 14.258 m2 totali) del 
materiale con SRI più critico, ovvero l’asfalto nero (SRI = 6) con un asfalto 
granulare grigio ad elevato SRI (SRI = 40). 

 

T.E.2 Capacità delle coperture di riflettere la radiazione solare 

Classe valore 
vulnerabilità attuale 

Coperture inclinate è: 0,47 – NEUTRALE 

Classe valore 
vulnerabilità attuale 

Coperture piane è: 1 – CRITICO 

Classe valore 
vulnerabilità neutrale Il livello CRITICO di vulnerabilità per le coperture piane è dovuto al fatto che si 

tratta di tetti neri bitumati. L’impatto sull’area urbana non è drammatico in 
quanto l’estensione di queste coperture è limitata. 

Misure di 
adattamento  

Si raccomanda di prevedere nel tempo la sostituzione di tutte le coperture 
piane bitumate con “cool roofs”, ovvero coperture ad elevato indice di 
riflessione solare o con tetti verdi. 

 

T.E.3 Riflettività zona urbana 

Classe valore 
vulnerabilità attuale 

0,69 – PIUTTOSTO NEGATIVO 

Classe valore 
vulnerabilità neutrale 

Per raggiungere la classe del valore di vulnerabilità NEUTRALE, è necessario 
raggiungere un valore dell’indicatore (estensione aree verdi / superficie zona 
urbana) pari al 24,4%. 

Ciò comporta un incremento del 28% del valore attuale dell’indicatore. Il 
valore dell’indicatore (36%) corrispondente alla classe di vulnerabilità 
NEUTRALE è stata derivato dai requisiti indicati nei CAM Edilizia per le aree 
esterne verdi in riferimento alle isole di calore. 



 

 

35 

Misure di 
adattamento  

- 

 

T.E.4 Disponibilità aree verdi 

Classe valore 
vulnerabilità attuale 

0,74 – PIUTTOSTO NEGATIVO 

Classe valore 
vulnerabilità neutrale 

Per raggiungere la classe del valore di vulnerabilità NEUTRALE, è necessario 
raggiungere un valore dell’indicatore (estensione aree verdi / superficie zona 
urbana) pari al 36%.  

Ciò comporta un incremento del 89% del valore attuale dell’indicatore. Il 
valore dell’indicatore (36%) corrispondente alla classe di vulnerabilità 
NEUTRALE è stato derivato dai requisiti indicati nei CAM Edilizia per le aree 
esterne verdi in riferimento alle isole di calore. 

Misure di 
adattamento  

Incrementare l’estensione delle aree verdi di 9.357 m2. 

 

T.E.5 Superfici Pavimentate Ombreggiate 

Classe valore 
vulnerabilità attuale 

0,60 – NEUTRALE 

Classe valore 
vulnerabilità neutrale 

Il livello di adattamento è appena sufficiente per le attuali condizioni 
climatiche ed è principalmente dovuto all’ombra proiettata dagli edifici. 

Misure di 
adattamento  

La piantumazione di alberi ad alto fusto è raccomandata per incrementare il 
livello di ombreggiamento e raggiungere un valore dell’indicatore (aree 
pavimentate ombreggiate il 21.06 ore 12.00 / superficie zona urbana) pari al 
30% corrispondente a una classe del valore di vulnerabilità pari a 0,4 - 
PIUTTOSTO POSITIVA.  

Per raggiungere tale obiettivo è necessario incrementare l’area ombreggiata 
delle superfici pavimentate di circa 2.800 m2. 

 

T.E.6 Vista della volta celeste 

Classe valore 
vulnerabilità attuale 

0,26 – PIUTTOSTO POSITIVA 
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Classe valore 
vulnerabilità neutrale 

Il valore dell’indicatore Sky View Factor è ottimale per favorire la dispersione 
del calore accumulato dalle superfici pavimentate e dalle coperture durante la 
notte. Non sono necessari interventi migliorativi. 

Misure di 
adattamento  

Nessuno. 
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